Getting Started

Physical Layout • Installation • USB and PS/2 Keyboard Connections • RS-232 Serial Connections • Changing Cables

Page 4

Reading Distances

2D Code Reading Distances • 1D Code Reading Distances • Setting the Focus Position

Page 10

Using the Reader

Trigger Types • The Setup Tool • Setup Tool General Toolbar

Page 13

Compliance Statements and Warnings

Agency Compliance Statements • Specifications and Precautions • Laser Information • Models and Accessories

Page 18
Physical Layout

- Trigger (press and hold to read)
- Indicator lamp
  - Green: read
  - Red: no read
- Illumination LEDs
- Aiming laser
- Lens
- Lens cover
- Release
- Cable lock

Installation

Check the Release Notes for a full list of system prerequisites.

Insert CD-ROM and follow on-screen prompts to install software.

Connect reader to PC.
- See pages 6-7 for connection details.
- Reader auto-detects USB, RS-232 and PS/2 connections.

Launch Setup Tool and click Refresh.
- Reader appears under COM ports as DM700
- Click Connect.

Start reading codes.
- See section Setting the Focus Position on page 12 to adjust lens for desired reading distance.
- Pages 10-11 list reading distances.
RS-232 Serial Connections

1. 6VDC power supply
2. Serial cable (DM700-RS232-00). Provide +5 to +6 VDC to connector on reverse or on pin 1.
3. (Optional) 24V to 5V power supply adapter (not included). Provide +6 to +24 VDC on pin 1; connect shield to ground. Adapter also converts TTL-level RS-232 signals to true RS-232 levels.
4. (Optional) Screw terminal plug (included with 24V-6V power supply adapter); use for your equipment.

USB and PS/2 Keyboard Connections

USB

1. Connect USB cable (DM700-USB-00) to USB port.
2. Scan code for serial port or keyboard emulation. **Note:** You must use serial emulation mode to connect to the DataMan Setup Tool.

PS/2 Keyboard

1. Connect serial cable. Do not connect power supply; reader powered through PS/2 connection.
2. Connect keyboard wedge cable. Reader automatically detects connection type.
3. (Optional) PS/2 keyboard; with no keyboard present, all keyboard input comes from reader.
4. PC with PS/2 keyboard connector.
Changing Cables

Disconnect DataMan from Power before adjusting focus.

Remove rubber plug.

Release cable lock using flat-head screwdriver.

Remove cable lock.

Using fine screwdriver, pick, or similar instrument, press RJ48 plug release tab while withdrawing cable.

Insert new cable, noting orientation of RJ48 plug. Press cable in until it locks in place.

1. Attach rubber plug to cable lock.

2. Press plug and lock into unit until it locks in place.
2D Code Reading Distances

A range of reading distances are available for different code sizes and focus positions (40mm, 65mm, and 105mm). Select a focus position that allows you to read the desired code sizes at the desired working distance.

1D Code Reading Distances

1. 102mm maximum code width at 143mm distance with 105mm focus setting (750S)
2. 140mm maximum code width at 177mm distance with 105mm focus setting (750)
Setting the Focus Position

Disconnect DataMan from Power before adjusting focus.

Release lens cover latch using screwdriver tip or coin.

Remove lens cover.

Align focus position to mark.

Replace lens cover.

Trigger Types

A DataMan 750 reader supports two trigger types:

- Presentation: Repeatedly scans for a symbol and decodes it whenever one is detected. The reader relies on an internal timing mechanism to acquire images.
- Manual (default): Begins acquiring images when you press the trigger button on the reader, and continues acquiring images until a symbol is found and decoded or you release the button.
The Setup Tool

Connect the reader to the Setup Tool to configure it with the type of symbologies it will decode as well as other parameters, such as the type of trigger it will use and the format of the results it will generate.

**Connect to Reader**
Establish a connection to the reader

**Results Display**
View results

**Light and Camera Settings**
Choose a trigger type and other acquisition parameters

**System Settings**
Configure input and output signals
Use the Setup Tool General Toolbar

Each reader can store its current set of run-time parameters to a configuration (.cfg) file, which contains information such as the enabled symbologies and how any output data should be formatted.

The same configuration file can be loaded onto multiple readers, as the file does not contain identification information such as the device name of the reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which stores the set of run-time parameters plus any identification data, such as the name of the device, trigger type, and so on. Cognex recommends generating a device configuration file for each reader to allow you to restore a reader to its operating state with minimal effort.

Use the File menu of the Setup Tool to manage .cfg and .cdc files:

<table>
<thead>
<tr>
<th>File Menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Configuration</td>
<td>Open a saved .cfg configuration file.</td>
</tr>
<tr>
<td>Save Configuration</td>
<td>Create a .cfg configuration file of current run-time parameters.</td>
</tr>
<tr>
<td>Print Configuration Code</td>
<td>Not supported on the DataMan 200.</td>
</tr>
<tr>
<td>Restore Device</td>
<td>Load a saved device configuration .cdc file, with run-time parameters plus device-specific information for a particular DataMan 200.</td>
</tr>
<tr>
<td>Backup Device</td>
<td>Create a device configuration .cdc file for a specific reader.</td>
</tr>
<tr>
<td>Load Image</td>
<td>Load an 8-bit uncompressed grey-scale .bmp or .jpg image for analysis.</td>
</tr>
</tbody>
</table>

Use the Edit menu for standard Cut, Copy and Paste operations.

Use the View menu to view reader information (serial number, firmware version, and so on) and to enable and disable various elements of the Setup Tool, and the Tasks menu to switch between various Setup Tool options.

Use the System menu to manage the current settings on the reader and to upgrade the features it currently supports:

<table>
<thead>
<tr>
<th>System Menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Settings</td>
<td>Save the current parameters to non-volatile memory, which allows the reader to restore these settings each time you reboot it.</td>
</tr>
<tr>
<td>Reset Configuration</td>
<td>Reset all configuration parameters in RAM (volatile memory) to the default settings.</td>
</tr>
<tr>
<td>Update Firmware</td>
<td>Update the reader software.</td>
</tr>
<tr>
<td>Upload Feature Key</td>
<td>Unlock additional features available in the reader software if you have the right key.</td>
</tr>
<tr>
<td>VeriCode License</td>
<td>Add VeriCode decoding by entering a license string provided by Veritek. Ask your Cognex sales representative for details.</td>
</tr>
</tbody>
</table>

Use the Help menu to display Setup Tool version information.
The DataMan 700 series meets or exceeds the requirements of all applicable standards organizations for safe operation. However, as with any electrical equipment, the best way to ensure safe operation is to operate them according to the agency guidelines that follow. Please read these guidelines carefully before using your device.

### Regulator Specification

<table>
<thead>
<tr>
<th>Regulator</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>FCC Part 15, Class A</td>
</tr>
<tr>
<td></td>
<td>FDA/CDRH Laser Notice No 50</td>
</tr>
<tr>
<td>Canada</td>
<td>ICES-003</td>
</tr>
<tr>
<td>European Community</td>
<td>EN55022 (CISPR 22) Class A</td>
</tr>
<tr>
<td></td>
<td>EN60950</td>
</tr>
<tr>
<td></td>
<td>EN60825-1</td>
</tr>
<tr>
<td>Australia</td>
<td>C-TICK, AS/NZS CISPR 22 / EN 55022 for Class A Equipment</td>
</tr>
<tr>
<td>Japan</td>
<td>J55022, Class A</td>
</tr>
</tbody>
</table>

### Agency Compliance Statements

#### FCC Class A Compliance Statement

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at personal expense.

#### Canadian Compliance

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

#### C-Tick Statement

Conforms to AS/NZS CISPR 22/ EN 55022 for Class A Equipment.

#### European Compliance

The CE mark on the product indicates that the system has been tested to and conforms with the provisions noted within the 2004/108/EC Electromagnetic Compatibility Directive and the 2006/95/EC Low Voltage Directive.

For further information please contact:

Cognex Corporation

One Vision Drive

Natick, MA 01760

USA

Cognex Corporation shall not be liable for use of our product with equipment (i.e., power supplies, personal computers, etc.) that is not CE marked and does not comply with the Low Voltage Directive.

#### Laser Safety Statement


This device has been tested in accordance with IEC60825-1 2nd ed., and has been certified to be under the limits of a Class 2 Laser device.

Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.
UL and cUL Statement

UL and cUL listed: UL60950-1 1st ed. and CSA C22.2 No.60950-1 1st ed.

For European Community Users

This product has required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment, if not properly disposed.

In order to avoid the dissemination of those substances in our environment and to diminish the pressure on the natural resources, we encourage you to use the appropriate take-back systems for product disposal. Those systems will reuse or recycle most of the materials of the product you are disposing in a sound way.

The crossed out wheeled bin symbol informs you that the product should not be disposed of along with municipal waste and invites you to use the appropriate separate take-back systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You may also contact your supplier for more information on the environmental performance of this product.

### Specifications and Precautions

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>110 g</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>0°C — 50°C (32°F — 122°F)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>0°C — 60°C (32°F — 140°F)</td>
</tr>
<tr>
<td>Maximum Humidity</td>
<td>95% (non-condensing)</td>
</tr>
<tr>
<td>ESD Safety (DataMan 750 only)</td>
<td>EN61000-4-2, IEC 61340-5-2, IEC 61340-5-1</td>
</tr>
<tr>
<td>Vibration</td>
<td>EN61373 including IEC 60068-2-6 and 60068-2-27</td>
</tr>
<tr>
<td>Codes</td>
<td>Data Matrix™ (DataMan 750: ECC 0, 50, 80, 100, 140, and 200; DataMan 750S: ECC200); QR Code and microQR Code; UPC/EAN/JAN; Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code 93, Pharma, Postal, RSS/CS, PDF 417, MicroPDF 417</td>
</tr>
<tr>
<td>Power Supply Requirements</td>
<td>5-6 VDC 2.5 W maximum LPS or NEC class 2 power supply</td>
</tr>
</tbody>
</table>

- **CAUTION**: Cable shield must be connected to earth ground to achieve listed ESD ratings.
- **CAUTION**: This device requires the use of an LPS or NEC class 2 power supply.
Laser Information

LASER LIGHT, DO NOT STARE INTO BEAM: CLASS 2 LASER PRODUCT
FAILURE TO FOLLOW THESE INSTRUCTIONS MAY CAUSE SERIOUS INJURY

- Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.
- Do not attempt to service or repair this product -- return it to Cognex for service.
- Do not permit anyone other than Cognex Corporation or Cognex-authorized personnel to service, repair, or adjust this product.
- Do not attempt to open or modify this device except as described in this document.
- Do not direct or reflect laser light toward people or reflective objects.
- Do not operate this device if it is damaged or if the covers or seals are missing or damaged.

This Laser Product is designated as Class 2 during all procedures of operation.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wavelength</td>
<td>650 nm</td>
</tr>
<tr>
<td>Laser Power for classification</td>
<td>&lt; 1 mW</td>
</tr>
<tr>
<td>Beam Diameter</td>
<td>&lt; 3mm at aperture</td>
</tr>
<tr>
<td>Divergence</td>
<td>&lt; 1.5 mrad</td>
</tr>
</tbody>
</table>

For assistance contact Cognex Corporation at http://support.cognex.com

Models and Accessories

DataMan 750 and 750S
The DataMan 750 includes the Cognex IDMax reading algorithm for reading difficult 2D codes which include low contrast and damaged codes. The DataMan 750S uses standard 1D and 2D reading algorithms for reading high quality 1D and 2D codes.

DM700-HOLDER-00
## Reader Control Codes

<table>
<thead>
<tr>
<th>Hard Reset</th>
<th>Soft Reset</th>
<th>USB Serial</th>
<th>USB Keyboard</th>
</tr>
</thead>
</table>

## Keyboard Language

<table>
<thead>
<tr>
<th>US English</th>
<th>German</th>
<th>French</th>
<th>Spanish</th>
<th>Japanese</th>
</tr>
</thead>
</table>

Copyright © 2010 Cognex Corporation All Rights Reserved. This document may not be copied in whole or in part, nor transferred to any other media or language, without the written permission of Cognex Corporation. The hardware and portions of the software described in this document may be covered by one or more of the U.S. patents listed on the Cognex web site http://www.cognex.com/patents.asp. Other U.S. and foreign patents are pending. Cognex, the Cognex logo, and DataMan are trademarks, or registered trademarks, of Cognex Corporation.